Array Formula
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Figure 20-9: Determining whether a range contains a
particular value.

The formula in cell E4 is as follows:

[=IF(OR(TestValue=Names),"Name is in the 1ist","Namg not

found")}

This formula compares TestValue to each cell in the range Names.

It builds a new

array that consists of logical TRUE or FALSE values. The OR functin returns TRUE

if any one of the values in the new array is TRUE. The IF function
message to display based on the result.

Counting Characters in a Range

This example demonstrates how to use nested functions in an arra
through each element in the input range. Figure 20-10 shows a worksheet with text
entered in a range named WordList.

The array formula in cell Bl is as follows:

{=SUM(LEN(WordList))}

termines which

iy formula to loop

This formula is quite straightforward. It creates an array that consists of the

length of each word in the WordList range. Then, it uses the SUM
the values in this new array. You can accomplish this without an

formula to add
array formula by

using an additional column of formulas and then summing the results.




HNumber of letters in WordList

Figure 20-10:

characters in

of students. Array formulas compare the two tesis and calculate the largest
decrease and the largest increase.

E

-5!Largest Decrease
Largest Increase

Figure 20-11; Array formulas determine the largest
decrease and|the largest increase in test scores.
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The formulas are as follows:

E3 {=MIN(C3:C11-B3:B11)}
E4: {=MAX(C3:C11-B3:B11)}

Looping Through Characters in a Cell

The following array formula calculates the sum of the digits in an integer, which is
stored in a cell named Number:

{=SUM(VALUE(MID(Number ,ROW($A$1:0FFSET($A$1, LEN(Numbep)-
1,00),100)1

This is a rather complex formula that makes use of an interesting trick; thus, it is
explained next one part at a time, so that you can see how it works. (Figure 20-12
shows an example.)

, - !
< - Sum of the digits (array formula)

the digits in a value.

You may be confused by the ROW function (this is the trick). This function is used
to generate an array of consecutive integers, beginning with 1 and ending with the
number of digits in the absolute value of Number.

If Number is 489, then LEN(Number) is 3. The ROW function can then be simplified
as follows:

{=ROW($A$1:0FFSET($A$1,3-1,0))}

This formula generates an array with three elements: {1,2,3}, which is used as the
second argument for the MID function (the third argument is 1). The MID part of the
formula, simplified a bit and expressed as values, is the following:

{=MID(489,{1,2,3},1))




!
E
This formula generates an array with three elements: {4,8,9}. By simplifying again
and adding the SUM function, the formula becomes as follows:

{=SUM({4,8,9})}
This produces the result of 21.

The following is another version of this formula that also works with negative
numbers. The ABS function is added to calculate the absolute value of the result:

{=SUM(VALUE (MID(ABS (Number) ,ROW($A$1: OFFSET($A$1, LEN(ABS (Number
))—1,o)ﬂ,1)))}

Summing Every nth Value in a Range

The next example can be quite useful. Suppose that you have a range of values
and you warnt to compute the sum of every third value in the list —the first, the
fourth, the seventh, and so on. You can’t accomplish this with a standard formula.
The following array formula does the job, however. It assumes that a cell named
Nth determines which values to sum, and that the range to sum is named Data.

{=IF(nth=0,0,SUM(IF(MOD(ROW($A$1:0FFSET($A$1,COUNT(Data)-
1,0)),nth)=0,Data,0)))}

The formulajuses the MOD function to determine which values to sum. The first
argument for the MOD function is as follows:

ROW($A$L:OFFSET($A$1,COUNT(Data)-1,0))

This expression generates an array that begins with 1 and ends with the number of
cells in the Data range. If the MOD function returns 0, the value is included in the
array to sumi.

Notice that a special case exists for when Nth is 0 (that is, sum every cell in the
range), because the MOD function returns an error when its second argument is 0.

This formula has a limitation: It works only when Data consists of a single column of
values, because it uses the ROW function to determine the element in the array.

Figure 20-13 shows an example that uses the preceding array formula, plus a series
of intermediary formulas to calculate the result without using an array formula.
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Figure 20-13: You can use an array formula to sum every
nth element in a range —or use a series of intermediary
formulas (a less-efficient approach).

An Alternate Method of Ranking

Often, computing rank orders for a
with the annual sales figures for 20 salespeople, for examp
how each person ranks, from highest to lowest.

le, you m

If you do this sort of work, you've probably discovered Excel's RANK

also may have noticed, however, that the ranks produced by this fur

handle ties the way that you may like. For example, if two values arej
place, they both receive a rank of 3. Many people prefer to assign

(or midpoint) of the ranks — that is, a rank of 3.5 for both values tie

Figure 20-14 shows a worksheet that uses two methods to rank a cd
(named Sales). The first method (column C) uses Excel's RANK fung
uses array formulas to compute the ranks.

The following is the array formula in cell D2:

1eS=BZ,1))}=1.(SUM(IF(-Sa]e5>=BZ,1,D)
(SUM(IF(Sales=B2,1)))-1)*0.5)}

{=IF((SUM(IF(Sa
ales»=B2,1)))-(
This formula was entered into cell D2 and then copied to the cells |

The formula is rather complex, but breaking it down into parts shg
understand how it works.

range of data is helpful. If you ha

ve a worksheet
ay want to know

_ function. You
ction don’t
tied for third

each an average

| for third place.

lumn of values

~tion. Column D

), (SUMCIF(S

helow it.

uld help you
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Assigned middle rank
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Figure 20-
formulas.

Figure 20-11

15, the only way to calculate frequency distributions was to use array
ginning with Excel 5, however, the COUNTIF function provides a more

1to 4. Column D contains array formulas to calculate the frequency of each score.

s N D LR e B N LD —

Figure 20-1
tions by usi

: Calculating discrete frequency distribu-

hg array formulas and COUNTIF functions.
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The formula in D6 is as follows:
{=SUM(IF(Scores=C3,1))}

The corresponding formulas in column E use the COUNTIF function.
is the formula in cell E6:

=COUNTIF(Scores,C3)

Both of these methods count specific values. But what if the scores ;

The following

are noninteger

values, as in Figure 20-16? Both types of formulas require modificati¢n to handle

noninteger data.

i

Score_ Formulas _Formulas
1 B B

2 7 7
3 5 5
4 B B

99

Figure 20-16: Calculating nondiscrete frequency distri-

butions by using array formulas and COUNTIF functions.

The array formula can be modified as follows:
=SUM(IF(Scores>=C3,1))-SUM(IF(Scores>=C4,1))

The following is the revised COUNTIF formula:

=COUNTIF(Scores,">="&C3)-COUNTIF(Scores,">="&C4)

The array formula requires you to add an additional value in column C, so that the
last array formula doesn’t refer to an empty cell (I added a value of §9).

You also can compute distributions by using the Histogram tool in

the Analysis

ToolPak (see Chapter 28). An advantage to using arrays or COUNTIF functions,

however, is that these procedures are dynamic and display the cor
you change the input data.

rect values if




DynamT: Crosstabs

The preceding section demonstrates that using COUNTIF is better than using array
formulas to|calculate frequency distributions. This section demonstrates how to
extend thesLs distributions into another dimension and create crosstabs. In this
case, an array formula is the only method that can get the job done. This technique
enables you to create a dynamic crosstab table that is updated automatically when-
ever the data is changed. Even a pivot table can’t do that!

The worksheet in Figure 20-17 shows a simple expense account listing. Each item
consists of the date, the expense category, and the amount spent. Each column of
data is a named range, indicated in the first row.

Food
4957
o0% 2780
N\ 101.96
%, 25.00
N

N

A

IFEIEF$2-DatasaCatoqones Amaurts)y

Figure 20-17: You can use array formulas to summarize data such as
thisin a dyr{amic crosstab table.
E

Array forml%ilas were used to summarize this information into a handy table that
shows the tptal expenses, by category, for each day. Cell F3 contains the following
array formula, which was copied to the remaining 11 cells in the table:

{=SUM(IF( $E3&F$2=DATES&CATEGORIES, AMOUNTS) )}
l

These arra)} formulas display the totals for each day, by category.

This formula operates similarly to the more simple one demonstrated in the pre-
ceding section. This formula has a few new twists, however. Rather than count the
number of entries, the formula adds the appropriate value in the Amounts range.
It does so, however, only if the row and column names in the summary table
matchithe corresponding entries in the DATES and CATEGORIES ranges. It does the
comparison by concatenating (using the & operator) the row and column names
and comparing the resulting string to the concatenation of the corresponding
DATES and CATEGORIES values. If the two match, the =SUM function kicks in and
adds the corresponding value in the AMOUNTS range.

[
I
i
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This technique can be customized, of course, to hold any number of ¢
categories and any number of dates. You can eliminate the dates, in f
substitute people’s names, departments, regions, and so on.

You also can cross-tabulate data by creating a pivot table. But, unlike a
using the procedure described here is completely dynamic (a pivot tah
updated if the data changes).

Pivot tables are discussed in Chapter 25.

Returning the Last Value in a Column

different
act, and

pivot table,
le must be

Suppose that you have a worksheet that you update frequently and need to deter-

mine the most recently entered value in a column. The following array
returns the contents of the last nonempty cell in the first 500 rows of ¢

=INDIRECT(ADDRESS(MAX((ROW(1:500)*(A1:A500<>""))),COLU

You can modify this formula to work with a different column, and with
number of rows in the column. To use a different column, change the ¢
ences from A to whichever column you need. To check more than 500 1
the two references to row 500. ’

Returning the Last Value in a Row

The following array formula is similar to the previous formula, but it re
nonempty cell in a row (in this case, row 1):

=INDIRECT(ADDRESS(1, (MAX((TRANSPOSE(ROW(1:256))*(1:1<

To use this formula for a different row, change the first argument for th
function to the new ADDRESS function and the 1:1 reference to corresp
YOW.

A Single-Formula Calendar

The final array formula example is perhaps the most impressive. Figure
a monthly calendar that is calculated using a single array formula entern

This workbook includes a few additional bells and whistles. For example

choose the month and year to display by using dialog box controls that
directly on the worksheet. When you change the month or year, the cal
updated immediately.

formula
olumn A:

MNCAZA)))

a different
olumn refer-

ows, change

turns the last

"))

e ADDRESS
ond to the

20-18 shows
ed in B6:H11.
, you can
are inserted
endar is




Figure 20-18: This calendar is calculated with a single array formula.

The array formula is as follows:

{=IF(MONTH(StartDate)<>MONTH(StartDate-StartDOW+Week*7+Weekday-
1),"",StartDate-StartDOW+Week*7+Weekday-1)}

This formula uses a few cell references (StartDate and StartDOW) and two named
array constants, which are defined as follows:

Week: {0;
Weekdaly: ={1

minutes to develop.

companion CD-ROM contains a workbook that uses the single-formula
dar.

Tips for Array Formulas

If you've followed along in this chapter, you probably understand the advantages of
using array formulas. As you gain more experience with arrays, you undoubtedly
~ will discover some disadvantages.
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The primary problem with array formulas is that they slow your worksheet’s recal-
culations, especially if you use large arrays. On a faster system, this may not bea
problem. But if you have a slower system and speed is of the essence, you should
probably avoid using large arrays.
Array formulas are one of the least understood features of Excel. Consequently, if
you plan to share a worksheet with someone who may need to make modifications,
you should probably avoid using array formulas. Encountering an array formula
when you don’t know what it is can be confusing.

You may also discover that you can easily forget to enter an array| formula by press-
ing Ctrl+Shift+Enter. If you edit an existing array, you still must use these keys to
complete the edits. Except for logical errors, this is probably the most common
problem that users have with array formulas. If you press Enter by mistake after
editing an array formula, just double-click the cell to get back into Edit mode and
then press Ctrl+Shift+Enter.

Summary

This chapter introduces the concept of array formulas, a special type of formula
that operates on a group of cells. You can write an array formula by entering a
single formula that performs an operation on multiple inputs and jproduces multiple
results —with each result displayed in a separate cell. This chapter also presents
several practical examples of array formulas.

+ 0+ 4+




f you use Excel on a standalone computer';a PC that’s

while user PCs are called clients (they use data in the centrally
stored files on the server). Other networks are peer-to-peer
networks that don't have a central server. Users on a network
can perform the following tasks

4+ Access files on other s‘ystems ;
4+ Shate files with other users
4 Share resources such as printers and faﬁ-modems |
+ Communicate with each other 'electroﬁjéal]y,
In many qffices, networks 1 now perform functmns that formerly b
required 4 mainframe system and dumb termmals Networks
~ are usually less expensive, easier to expand, more manageable

and more flexible in terms of software avaxlabﬂlty thana
mainframe system.

This chapter discusses the Excel features that are demgned
for netwark users.

File Reservations

Networks provide users with the ability to share information
stored on other computer systems. Most networks have one
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or more file servers attached. A file server stores files that members of a workgroup
share. A network’s file server may contain, for example, files that store customer
lists, price lists, and form letters. Keeping these files on a file server has two major
advantages:

4 It eliminates the need to have multiple copies of the files stored locally on
user PCs.

4 It ensures that the file is always up to date; for example, if everyone makes
changes to the same shared copy of a customer list, there’s little likelihood
that the portions of the list will be correct while other portions will be
obsolete.

Some software applications are multiuser applications. Most database software
applications, for example, enable multiple users to work simultaneously on the
same database files. One user may be updating customer records i the database,
while another is extracting records. But what if a user is updating a customer
record and another user wants to make a change to that same record? Multiuser
database software contains record-locking safeguards that ensure @nly one user
at a time can modify a particular record.

Excel is not a multiuser application. When you open an Excel file, the entire file is
loaded into memory. If the file is accessible to other users, you wo ldn’t want
someone else to open a file that you've opened. If Excel allowed you to open and
change a file that someone else on a network has already opened, the following
scenario could happen.

Assume that your company keeps its sales information in an Excel file that is stored
on a network server. Elaine wants to add this week’s data to the file, 'so she loads it
from the server and begins adding new information. A few minutes later, Albert
loads the file to correct some errors that he noticed last week. Elaine finishes her
work and saves the file. A while later, Albert finishes his corrections and saves the
file. Albert’s file overwrites the copy that Elaine saved, and her additions are gone.

This scenario can’t happen, because Excel uses a concept known as file reservation.
When Elaine opens the sales file, she has the reservation for the file) When Albert
tries to open the file, Excel informs him that Elaine is using the file. If he insists on
opening it, Excel opens the file as read-only. In other words, Albert can open the file,
but he can't save it under the same name. Figure 21-1 shows the message that
Albert receives if he tries to open a file that is in use by someone else.

Figure 21-1: The File in Use dialog box appears if
you try to open a file that someone else is using.




Albert has these three choices:
4+ Select Cancel, wait a while, and try again. He may call Elaine and ask her
when she expects to be finished.

4 Select Read Only. This lets him open the file to read it, but doesn’t let him
save changes to the same filename.

4 Select Notify, which opens the file as read-only. Excel pops up a message
when Elaine is finished using the file.

Figure 21-2 shows the message that Albert receives when the file is available.

Figure 21-2: The File Now Available dialog box
pops up with a new message when the file is
available for editing.

Shared Workbooks |

Although Excel isn’t a multiuser application, it does support a feature known as
shared workbooks, which enables multiple users to work on the same workbook
simultaneously. Excel keeps track of the changes and provides appropriate
prompts|to handle conflict.

Appropriate Workbooks for Sharing

Although you can designate any workbook as a shared list, only certain workbooks
contain information that is appropriate for sharing. The following are examples of
workbooks that work well as shared lists:

4+ Project tracking: You may have a workbook that contains status information
for |projects. If multiple people are involved in the project, they can make
changes and updates to the parts that are relevant.

4 Customer lists: With customer lists, changes usually occur infrequently, but
recprds are added and deleted.

4+ Consolidations: You may create a budget workbook in which each depart-
ment manager is responsible for his or her department’s budget. Usually, each
department’s budget appears on a separate sheet, with one sheet serving as
the consolidation sheet.
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Limitations of Shared Workbooks

If you plan to designate a workbook as shared, be aware that you cannot perform
any of the following actions while sharing the workbook:
4 Delete worksheets or chart sheets.

4 Insert or delete a block of cells. However, you can insert or delete entire
rows and columns.

4 Merge cells.

4 Define or apply conditional formats.

4 Set up or change data-validation restrictions and messages.
4 Insert or change charts, pictures, drawings, objects, or hyperlinks.

4 Assign or modify a password to protect individual worksheets or the entire
workbook.

4 Create or modify pivot tables, scenarios, outlines, or data tables.
4 Insert automatic subtotals.
4 Make changes to dialog boxes or menus.

4 Write, change, view, record, or assign macros. However, you can record a
macro in a shared workbook that you store in another, unshared workbook.

Designating a Workbook As a Shared Workbook

To designate a workbook as a shared workbook, select Tools => Share Workbook.
Excel displays the dialog box that is shown in Figure 21-3. This dialgg box has two
tabs: Editing and Advanced. In the Editing tab, select the check box|to allow changes
by multiple users and then click OK. Excel then prompts you to save the workbook.

When you open a shared workbook, the window’s title bar displays [Shared]. If you
no longer want other users to be able to use the workbook, remove the check mark
from the Share Workbook dialog box and save the workbook.

Whenever you're working with a shared workbook, you can find out whether any
other users are working on the workbook. Choose Tools = Share Workbook, and the
Share Workbook dialog box lists the names of the other users who have the file open,
as well as the time that each user opened the workbook.




Figure 21-3; The Share Workbook dialog
box lets you specify a workbook as a
shared workbook.

Advanced Settings

Excel allows you to set options for shared workbooks. Select Tools = Share Workbook
and click the Advanced tab to access these options (see Figure 21-4).

Figure 21-4: The Advanced tab of the
Share Workgaook dialog box.

|
|
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Tracking changes

Excel can keep track of the workbook’s changes — something knawn as change
history. When you designate a workbook as a shared workbook, Excel automatically
turns on the change history option, enabling you to view information about previous
(and perhaps conflicting) changes to the workbook. You can tumaﬁ)ff change history
by selecting the option labeled Don't keep change history. You can also specify the
number of days for which Excel tracks change history.

Updating changes
While you're working on a shared workbook, you can use the standard File= Save

command to update the workbook with your changes. The Upcla.?te changes settings
determine what happens when you save a shared workbook: 1

. H
4 When file is saved: You receive updates from other users when you save your
copy of the shared workbook.

from other users of the workbook. You can also specify whether Excel should
save your changes automatically, too, or just show you the
other users.

4 Automatically every: Lets you specify a time period for reaFeiving updates

changes made by

|
Conflicting changes between users E

As you may expect, multiple users working on the same file can réisult in some con-
flicts. For example, assume that you're working on a shared cust‘?er database worl-

book, and another user also has the workbook open. If you and the other user both
make a change to the same cell, a conilict occurs. You can specify|the manner in
which Excel resolves the conflicts by selecting one of two options|in the Advanced
tab of the Share Workbook dialog box:

4+ Ask me which changes win: If you select this option, Excel displays a dialog
box to let you determine how to settle the conflict.

+ The changes being saved win: If you select this option, your changes always
take precedence.

Include in personal view
The final section of the Advanced tab of the Share Workbook diglog box enables
you to specify settings that are specific to your view of the sharetd workbook. You
can choose to use your own print settings and your own data-filtering settings. If
you don’t place checks in these check boxes, you can’t save your own print and
filter settings.




Mailing and Routing Workbooks

Excel prpvides a few additional workgroup features. To use these features, your
system 1{1‘1ust have one of the following items installed:

4 Office 2000
4 Microsoft Exchange

4 A pail system that is compatible with MAPI (Messaging Application
Programming Interface) i

4+ Lotus cc:Mail
i
+ A rEnail system that is compatible with VIM (Vendor Independent Messaging)

The prof:eclures vary, depending on the mail system that you have installed; for
this reason, discussions in the following sections are general in nature. For specific
_questiofps, consult your network administrator.

Mailing a Workbook As an E-mail Attachment

Electroniic mail, or e-mail, is commonplace in most offices, and is an extremely.
efficient means of communication. Unlike a telephone, e-mail doesn’t rely on the
recipient of the message being available when you want to send the message.

In addition to sending messages by e-mail, you can send complete files — including
Excel workbooks. Like a growing number of software applications, Excel is mail-
enabled|which means that you don’t have to leave Excel to send a worksheet to
someone by e-mail.

To send ja copy of your workbook to someone on your network, select File=> Send
To=>Mail Recipient (as Attachment). Excel creates an e-mail message with a copy of
the workbook attached, using your default e-mail program; in Figure 21-5, Excel
opened Outlook Express to send the workbook. You send this e-mail message the
same way that you send any message —from your e-mail program. You also can
send the message to multiple recipients, the same way that you send any e-mail
message to multiple recipients.
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Figure 21-5: Sending a workbook as an attachment to an e-mail message.

When you send any file by using an e-mail program, you send a gopy of the file. If
the recipient makes changes to the notebook, the changes do nat appear in your

copy of the workbook.

Routing a Workbook to Others

If you choose File=> Send To = Routing Recipient, Excel enables you

to attach a rout-

ing slip to a workbook, similar to the one you see in Figure 21-6. Rguting a workbook
is most useful when you want the first person in the group to review (and possibly
edit) the workbook and then send it to the next person on the list. For example, if
you're responsible for your department’s budget, you may need input from Alice —
and her input may depend on Andy’s input. You can set up the wml)kbook and then

route it to the others so that they can make their respective additi

ns. When you set

up the routing slip, you can tell Excel to return the workbook to you when the rout-

ing is finished.




Figure 21-6: Routing a workbook.

When you rc!ute a workbook, you have the following two options:
|

4 Sequential routing: Enables you to route the workbook sequentially to work-
group members. When the first recipient is finished, the workbook goes to the
second recipient. When the second recipient is finished, the workbook goes to
the third, and so on. When all recipients have received the workbook, it can
be returned to you. Choose One after another at the bottom of the Routing
Slip dill;)lg box for this type of routing.

4+ Simultaneous routing: Enables you to route the workbook to all recipients
at once. You receive a copy of the workbook from each recipient (not just
one coiny). This type of routing is useful if you want to solicit comments
from a group of coworkers, and you want the responses back quickly (you
don’t want to wait until a single worksheet makes the circuit). Choose All at
once at the bottom of the Routing Slip dialog box for this type of routing.

Click Route to route the workbook immediately. If you don’t want to route
immediately, click Add Slip. Later, when you're ready to route, choose File=> Send
To=> Next Routing Recipient. Either choice places the workbook in the outgoing
mail folder of your e-mail program. To actually route the workbook, open your
e-mail program to send the message.
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Whether you route or attach a workbook to an e-mail message, Excel uses your
e-mail program. Since you can send a workbook to a number of peaple, either as
an e-mail attachment or by using a routing slip, the distinction between the two
methods lies in the distinction between sequential and simultanequs routing. If
you choose simultaneous routing and you don't place a check in the|Return when
done check box, routing and attaching are identical, because you can't guarantee
a reply to e-mail.

Summary

This chapter presents a basic overview of using Excel in a network environment. It
explains how the concept of a file reservation prevents two users from modifying a
workbook simultaneously. Excel’s shared workbook feature, however, lets multiple
users work on a single workbook at the same time. The chapter concludes with a

discussion of mailing and routing workbooks.
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Importing Data
from Other

late data,
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When you get right down to it, Excel can be described
as a tool that manipulates data— the numbers and
text that you use in a worksheet. But before you can manipu-

describes a variety of data-importing techniques.

An Overview of Importing

The following are the six basic ways to import data into Excel:

+ Enter the data manually by typing values and text into

nerate data by using formulas or macros

4+ Use Query (or a pivot table) to import data from an
external database

port data from an HTML document on the Internet or
a corporate intranet

4+ Copy data from another application by using the Windows
Clipboard

+ ]Hiport data from another (non-Excel) file
|
This chapter deals primarily with the last two methods:
Clipboard copying and foreign-file importing.
iirl;r(ing to and from other applications and embedding

ects. Querying external databases is covered in Chapter

dijcusses how Excel works with the Internet.

it must be present in a worksheet. This chapter

S

pter 29 is somewhat related to this topic. It deals with

and pivot tables are covered in Chapter 25. Chapter 30
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A Few Words About Data

Data is a broad concept that means different things to different peo

basically raw information that can come in any number of forms. Fq
can be numbers, text, or a combination. Most of what you do in Exc
manipulating data in one way or another.

As computers become more commonplace, data is increasingly avai
readable formats (otherwise known as files). Not too long ago, majo:
provided printed reports to their clients. Now, data suppliers comm
choice of formats: paper or disk.

Data that is stored in files can be in a wide variety of formats, Comm
for distributing data include Lotus 1-2-3 files (WKS and WK1), dBASI
text files (which come in several varieties). Excel’s file format is rath
the format tends to change with every new version of Excel. Conseq
file format is not widely used for the general distribution of data.
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The file format for Excel 2000 files is the same as the file format for Excel 97.

However, if you use an Excel 2000 file in Excel 97, you will have
Excel 97 features.

As an Excel user, you need to understand the types of data that yot
either directly or indirectly.

File Formats Supported by Excel

Rarely does a computer user work with only one application or inte
people using the same applications he or she uses. Suppose that y¢
a spreadsheet model that uses data from last year’s budget, which
company’s mainframe. You can request a printout of the data, of ca

access only to

1 can access

>ract only with

yu're developing
is stored in your
urse, and manu-

ally enter it into Excel, If the amount of data isn’t too large, this route may be the

most efficient. But what if you have hundreds of entries to make? V)
probably can’t generate an Excel workbook file, but an excellent ch
it can send the report to a text file, which you can then import into
sheet. Potentially, you can save several hours of work and virtually
entry errors.

As you know, Excel’s native file format is an XLS file. In addition, Mi
the capability to read other file formats directly. For example, you ¢
that was created in several other spreadsheet products, such as Ld
Quattro Pro. Table 22-1 lists all the file formats that Excel can read

own file types).

To open any of these files, choose File=> Open and select the file typ
down list labeled Files of type (see Figure 22-1)to display only the filg

our mainframe
ance exists that
an Excel work-
eliminate data-

crosoft included
can open a file
tus 1-2-3 and
(excluding its

e from the drop-
»s of the selected




type in theffile list. If the file is a text file, Excel’s Text Import Wizard appears, to help
you interpret the file. The Text Import Wizard is discussed later in this chapter.

File Type : Description

Lotus 1-2-3 preadsheet files generated by Lotus ?-2—3 for DOS Release
1x, Release 2.x, Release 3.x and 1-2-3 for Windows
e

Figure 22-: Use the Open dialog box to import a foreign file.
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You should understand, however, that being able to read a file and tz

perfectly are two different matters. In some cases, you may encount
of the following problems while reading a foreign file into Excel:
4 Some formulas aren't translated correctly
4 Unsupported functions aren’t translated
4 Formatting is incorrect

4 Column widths are incorrect

When you open a file that wasn’t produced by Excel, examine it care

that Excel retrieved the data correctly.

The following sections discuss the various types of files that Excel ¢
section discusses a file type and lists that file type’s associated file ¢

anslating it
er ONle Or more

fully to ensure

an read. Each
xtensions.

If a colleague sends you a file that Excel can’t open, don’t give up. Simply ask your

colleague to save the spreadsheet in a format that Excel can read. For

example, many

applications can save files in 1-2-3 format, and most applications can export to a text

file format.

Lotus 1-2-3 Spreadsheet Files

Lotus spreadsheets come in several flavors:

4 WKS files: Single-sheet files used by 1-2-3 Release 1.x for DOS.
and write these files. If you export a workbook to a WKS file, E;
the active worksheet, because 1-2-3 Release 1.x supports only
per workbook.

4+ WKI1 files: Single-sheet files used by 1-2-3 Release 2.x for DOS.

Excel can read
xcel saves only
one worksheet

The formatting

for these files is stored in ALL files (produced by the Allways ddd-in) or FM1

files (produced by the WYSIWYG add-in). Excel can read and «
file types. When you save a file to the WK1 format, you can chg
any) type of formatting file to generate. And, like WKS files, if ¥

workbook to a WK1 file, Excel saves only the active worksheeti,

4+ WKS3 files: Multisheet (potentially) files generated by 1-2-3 Rels
1-2-3 Release 4.x for DOS, and 1-2-3 Release 1.x for Windows. Tk
these files is stored in FM3 files (produced by the WYSIWYG ad
read and write WK3 files with or without the accompanying FM

4+ WK4 files: Multisheet (potentially) files generated by 1-2-3 Rel
Windows and 1-2-3 Release 5.x for Windows. Lotus combined f
data into one file, eliminating the separate formatting file. Exc¢
write these files.

4+ 1-2-3 files: Multisheet (potentially) files generated by 1-2-3 97
Release 6) and 1-2-3 Millenium Edition (also known as Release
neither read nor write these files.

rite all of these
pose which (if
ou export a

ase 3.x for DOS,
e formatting for
d-in). Excel can
3 file.

ease 4.x for
prmatting and
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(also known as
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If you plan to import or export 1-2-3 files, [ urge you to read the online Help for
general guidelines and for specific types of information that may not be translated.

Excel evaluates some formulas differently from 1-2-3. To ensure complete compati-
bility when you work with an imported 1-2-3 file, choose Tools = Options, select the
Transiti]on tab, and then check the box labeled Transition Formula Evaluation.

z

Qua?ro Pro Spreadsheet Files

Quattro Pro files exist in several versions:

+ W’Ql files: Single-sheet files generated by Quattro Pro for DOS Versions 1, 2, 3
d 4. Excel can read and write these files. If you export a workbook to a WQ1
file, Excel saves only the active worksheet.

2 files: Multisheet (potentially) files generated by Quattro Pro for DOS
Version 5. Excel can neither read nor write this file format.

+ 1 files: Multisheet (potentially) files generated by Quattro Pro for Windows
Versions 1 and 5 (there are no Versions 2 through 4). Excel can read (but not
write) this file format.

+ :4]32 files: Multisheet (potentially) files generated by Quattro Pro for

1

ndows Version 6. Excel can neither read nor write this file format.

Dataii:ase File Formats

DBF files are single-table database files generated by dBASE and several other data-
base programs. Excel can read and write DBF files up to and including dBASE 4.

If you have Microsoft Access installed on your system, you can take advantage of
a feature that converts a worksheet list into an Access database file. To use this
feature; you must install the Access Links add-in in Excel (you need your Office
2000 CD-ROM). Use the Data=» Convert to MS Access command.

Excel can't read or write any other database file formats directly. If you install the
Query add-in, however, you can use Query to access many other database file
formatg and then copy or link the data into an Excel worksheet.

See Chapter 24 for details on how to use Query to copy or link data from other
database file formats into an Excel worksheet.

Text File Formats

Text files simply contain data— no formatting. The following relatively standard
text file formats exist, although no standard file extensions exist:
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4 Tab-delimited files: Each line consists of fields that are separated by tabs.
Excel can read these files, converting each line to a row and each field to a
column. Excel also can write these files, using TXT as the default extension.

4 Comma-separated files: Each line consists of fields that are separated by
commas. Sometimes, text appears in guotation marks. Excel can read these
files, converting each line to a row and each field to a column. F.xcel can also
write these files, using CSV as the default extension.

4 Space-delimited files: Each line consists of fields that are se arated by
spaces. Excel can read these files, converting each line to a row and each
field to a column. Excel also can write these files, using PRN ds the default
extension.

If you want your exported text file touse a different extension, specify the complete
filename and extension in quotation marks. For example, saving a workbook in
comma-separated format normally uses the CSV extension. If you want your file to
be named output.txt (with a TXT extension), enter “output.txt” in the File name box
in the Save As dialog box.

When you attempt to load a text file into Excel, the Text Import Wizard kicks in to
help you specify how you want Excel to retrieve the file (discussed|in detail later in
the chapter).

HTML Files

Fxcel can read and save files in HTML (Hypertext Markup Language) format, a file
format that is used on the World Wide Web. And, through the use of XML (Extensible
Markup Language), HTML files retain all document properties, including fonts and
formatting.

Using Excel, you can edit any Excel document from within a Web browser. While you
are viewing a page that was created in an Office application, such as Excel, click the
Edit button on the browser’s toolbar. Office opens the document in the application
that was used to create it. You can then edit the Web page and resave it in any of the
file formats that the application supports or in HTML.

Other File Formats

The following are two other types of file formats that you will rarely encounter;
I haven’t seen a DIF file in ages, and I've never seen a SYLK file.

+ Data Interchange Format (DIF): Used by VisiCalc. Excel caﬁm read and write
these files. |

4 Symbolic Link (SYLK): Used by MultiPlan. Excel can read aJJld write these files.




Using the Clipboard to Get Data

Using the Windows Clipboard is a another method of importing data into your
worksheet. The process involves selecting data from another application and
copying the data to the Clipboard. Then, you reactivate Excel and paste the
information to the worksheet. The exact results that you get can vary quite a bit,
depending on the type of data that you copied and the Clipboard formats that it
supports. Obviously, you must have a copy of the other application installed on
your system.

If you copy information from another Office application, you use the Office
lipboard, not the Windows Clipboard. The Office Clipboard supports copying and
sting of all formats used in all Office applications.

AboLt the Clipboard

As youl read in Chapter 8, Office 2000 provides Windows 95 or Windows 98 with two
clipboards. The original Windows Clipboard remains; whenever you cut or copy
information from a Windows program, Windows stores the information on the
Windows Clipboard, which is an area of memory. Each time that you cut or copy
information, Windows replaces the information previously stored on the Clipboard
with the new information that you cut or copied. The Windows Clipboard can store
data in a variety of formats. Because Windows manages it, information on the
Windows Clipboard can be pasted to other Windows applications, regardless of
where |t originated. Normally, you can’t see information stored on the Windows
Clipboard (nor would you want to).

To view the Windows Clipboard contents, you can run the Clipboard Viewer pro-
gram, which comes with Windows. The Clipboard Viewer may or may not be
{ln?stalled on your system (it is not installed by default). You can use the Clipboard

iewer to view only the last piece of information that you copied to the Office
C{Iipboard.

When you copy or cut data to the Clipboard, the source application places one or
more formats on the Clipboard along with the data. Different applications support
different Clipboard formats. When you paste Clipboard data into another applica-
tion, the destination application determines which format it can handle and typi-
cally selects the format that either provides the most information or is appropriate
for where you are pasting it. If you view cells copied from Excel in the Clipboard
Viewer by default, you'll see a row/column reference rather than the actual infor-
matiori:‘hat you copied (see Figure 22-2). In some cases, you can use the Display
command in the Clipboard Viewer application to view the Clipboard data in a differ-
ent format. For example, you can display a range of cells from Excel as a picture,
bitmap, text, OEM text, or a DIB bitmap. Figures 22-3, 224, 22-5, and 22-6, show
examples of the same Excel range as it appears in the Clipboard Viewer when using
different Display formats.

World Programming Limited EXHIBIT 1007; Page 156 of 241



Figure 22-2: The Windows Clspboard \fewer appllcatlon displaying Excel #000
data in default format, Display Text.

Figure 22-3: The same data in Picture format.




4: Both Bitmap and DIB Bitmap format closely resemble the formatted
e of the data in Excel.

_{Nuomh 123 133

_.{South 101

Figure 22-5: The Text format shows the text similar to the way that it appears
in the Notepad.
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Figure 22-6: The OEM text format.

Importantly, the format that you select in the Clipboard Viewer doesn'tlaffect how
Excel copies the data. In some cases, however, you can use Excel’s Edit= Paste

Special command to select alternate methods of pasting the data.

Copying Data from Another Windows Applicaition

Copying data from one Windows application to another is quite straig
The source application contains the data that you're copying, and the
application receives the data that you're copying. Use the following steps to copy
data from one application into another:

tforward.
stination

1. Activate the source document window that contains the information you want

to copy.
2. Select the information that you want to copy by using the mous

e or the

keyboard. If Excel is the source application, this information can be a cell,

range, chart, or drawing object.

3. Select Edit= Copy (or any available shortcut). A copy of the inig
sent to the Windows Clipboard. If you're copying from an Office
a copy of the information is also sent to the Office Clipboard.

4. Activate the destination application. If it isn’t open, you can start
affecting the contents of the Clipboard.

prmation is
application,

it without




5. Move to the position to which you want to paste in the destination application.

6. Select Edit=> Paste from the menu in the destination application. If the
Clipboard contents aren’t appropriate for pasting, the Paste command is
grayed (not available).

In Step 3, you also can select Edit = Cut from the source application menu. This step
erases the selgction from the source application after it's placed on the Clipboard.

Many Windows applications use a common keyboard convention for the Clipboard
commands. Generally, this technique is a bit faster than using the menus, because
these keys are|adjacent to each other. The shortcut keys and their equivalents are
the following:

Ctrl+C Edit= Copy
Ctrl+X FEdit= Cut
Ctrl+V Edit= Paste

You need to understand that Windows applications vary in how they respond to data
that you paste from the Clipboard. If the Edit = Paste command isn’t available (it is
grayed on the menu) in the destination application, the application can't accept the
information from the Clipboard. if you copy a table from Word for Windows to Excel,
the data translates into cells perfectly —complete with formatting. Copying data from
other applications may not work as well; for example, you may lose the formatting, or
you may end up with all the data in a single column rather than in separate columns.
As discussed later in this chapter, you can use the Convert Text to Columns Wizard to
convert this data into columns.

If you plan to do a great deal of copying and pasting between two applications,
experiment until you understand how the two applications can handle each
other’s data.

Copying Data from a Non-Windows Application

You also can use the Windows Clipboard with non-Windows applications running
in a DOS windpw. As you may know, you can run non-Windows programs from
Windows either in a window or in full-screen mode (the application takes over the
complete scregen).

When you're qunning a non-Windows application in Windows, you can press
Alt+Print Screen to copy the entire screen to the Clipboard. The screen contents
can then be pasted into a Windows application (including Excel). To copy only
part of the screen, you must run the application in a window: press Alt+Enter to
toggle between full-screen mode and windowed mode. You can then click the
Control menu, choose Edit = Mark, and select text from the window. This window
may or may not have a toolbar displayed. If it does not, follow these steps:

1. Right-click the title bar and select the Toolbar option.
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2. Click the Mark tool and select the text to copy.

3. Click the Copy tool to copy the selected text to the Clipboard.
4, Activate Excel.

5. Select Edit > Paste to copy the Clipboard data into your worksheet.

Figure 22-7 shows Quattro Pro running in a DOS window. Some text is selected.

|=" Select - Quattio Pro for DOS

J=33 REPORT FOR ROBERT GAINES

$340.05 $452.00 $340

Figure 22-7: Copying data from Quattro Pro for DOS.

If you use this technique and copy to Excel, the information is pasted as text in a
single column. In other words, even if you copy information from neatly formatted
columns, it’s all pasted into a single column in Excel. But don’t fret—you can use
Excel’s Convert Text to Columns Wizard to convert this data into columns.

You're limited to copying one screen of information at a time—you cari’t scroll the
DOS application while you're selecting text.

Importing Text Files

Text files (sometimes referred to as ASClII files) are usually considered to be the
lowest-common-denominator file type. Such files contain only data, with no format-
ting. Consequently, most applications can read and write text files, So, if all else
fails, you can probably use a text file to transfer data between two applications that
don’t support a common file format. Because text files are so commonly used, this
entire section is devoted to discussing them and explaining how to useg Excel’s Text
Import Wizard.




About Text Files

You may find it helpful to think of some text files in terms of a database table. Each
line in the text file corresponds to a database record, and each record consists of a
number| of fields. In Excel, each line (or record) is imported to a separate row, and
each field goes into a separate column. Text files come in two types: delimited and
nondelimited.

Text files consist of plain text and end-of-line markers. Delimited text files use a
special character to separate the fields on each line —typically a comma, a space,
or a tab|(but occasionally, you'll see other delimiters used). In addition, text is
usually (but not always) enclosed in quotation marks.

Nondelimited files don’t contain a special field-separator character. Often, however,
each field is a fixed length, enabling you easily to break each line of text into sepa-

rate colpmns. When you view a nondelimited file, the data often appears to be in
columns.

If you use a proportional font, such as Arial or Times Roman, the fields of text file
may appear to not line up, although they actually do. In proportional font sets, each
character uses a different amount of horizontal space. For best results, use a non-
proportional font, such as Courier New, when working with text files. Excel uses
Courier New in its Text Import Wizard dialog box. Figure 22-8 shows the same text
displayed in Arial and Courier New fonts.
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Figure 22-8:

Excel is

Using a proportional font may obscure columns in a text file.

quite versatile when importing text files. If each line of the text file is iden-
tically laid out, importing is usually problem-free. But if the line contains mixed
information, you may need to do some additional work to make the data usable.
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For example, you create text files in some programs by sending
a disk file rather than to the printer. These reports often have ¢
such as page headers and footers, titles, summary lines, and so

Using the Text Import Wizard

Prior versions of Excel treated importing text files differently fr
database information. In Excel 2000, if you use the technique d
section, you'll create a Text File Query, which you can refresh i
you refresh Database and Web queries. This new feature will m
of those who need to regularly import text files, because they w

up” the import each time. When you want to update the Excel fil

a printed report to
xtra information,
on.

m other types of
cribed in this

the same way that
e easier the lives
n’t need to “set

e that you create

by importing a text file, choose Data = Refresh Data. Highlight the text file that you
originally imported and click the Import button. Excel automatically updates the
Excel version of the file with any new data that may appear in the text file.

For more information on Database queries, see Chapter 24, Fo
on Web queries, see Chapter 30.

To import a text file into Excel, choose Data > Get External Data
In the Import Text File dialog box, navigate to the folder contain
want to import. The dialog box then displays text files that have
TXT. If the text file that you're importing has a different extensid
Files option. Or, you can enter the filename directly into the File
know the file’s name.

Excel displays its Text Import Wizard, a series of interactive dial

you specify the information that Excel requires to break the line
columns. You can truly appreciate this time-saving feature if, in
struggled with the old data-parsing commands that are found in
programs and older versions of Excel.

Text Import Wizard: Step 1 of 3

Figure 22-9 shows the first of three Text Import Wizard dialog bosx
data type section, verify the type of data file (Excel almost always
You also can indicate the row that Excel should use to start importing. For example, if
the file has a title in the first row, you may want to skip the first line.

Notice that you can preview the file at the bottom of the dialo
scrollbars to view more of the file. If the characters in the file
may need to change the File Origin; this determines which che
many cases, it doesn’t make any difference). After you finish w
the Next button to move to Step 2.

r more information

> Import Text File.
ing the file that you
an extension of

n, select the All
name bog, if you

og boxes in which
s of the text file into

a previous life, you

other spreadsheet

xes. In the Original
s guesses correctly).

5 box, using the
don’t look right, you
iracter set to use (in
vith this step, click




Figure 22-9: Step 1 of the Text Import Wizard.

Text Import Wizard: Step 2 of 3

The dialog box that you see for Step 2 of the Text Import Wizard varies, depend-
ing on your choice in the Original data type section in Step 1. If you selected
Delimited, you see the dialog box shown in Figure 22-10. You can specify the type
of delimiter, the text qualifier, and whether to treat consecutive delimiters as a
single delimiter; choosing to treat consecutive delimiters as a single delimiter
tells Excel to skip empty columns. The Data preview section displays vertical
lines to indicate how Excel will break up the fields. The Data preview section
changes as qu make choices in the dialog box.

|
If you selected Fixed width, you see the dialog box shown in Figure 22-11. At this
point, Excel attempts to identify the column breaks and displays vertical break lines
to represent how it will break fields apart into columns. If Excel guesses wrong, you
can move the lines, insert new ones, or delete lines that Excel proposes. You'll see
instructions in the dialog box.
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Text Import Wizard: Step 3 of 3

Figure 22-12 shows the last of the three Text Import Wizard dialog boxes. In this
dialog box, you can select individual columns and specify the formatting to apply
(General, Text, or Data). You also can specify columns to skip—they aren’t imported.
If you click the Advanced button, you'll see the dialog box shown in Figure 22-13, in
which you can specify characters to use as decimal and thousands separators. When
you're satisfied with the results, click Finish. Excel prompts you for the starting cell
location for the imported data; when you click OK, Excel imports the data and
displays the External Data toolbar, which helps you to work with the imported text
file (see Figure 22-14). For example, if you click the Data Range Properties tool, you
see the External Data Range Properties dialog box, shown in Figure 22-15, which you
can use tg change how Excel treats the imported file.

Figure 22413: The Advanced Text Import
Settings dialog box.
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Maria

Figure 22-15: Use this dialog box to change
the way that Excel treats the imported file.




If the results aren’t what you expect, close the workbook and try again (text import-
ing often involves trial and error). Don’t forget that you can scroll the Data Preview
window to make sure that all the data is converted properly. With some files, how-
ever, importing all the data properly is impossible. In such cases, you may want to
import the file as a single column of text and then break lines into columns selec-
tively. The|procedure for doing this is discussed in the next section.

Using the Text to Columns Wizard

Excel can parse text that is stored in a column. Start by selecting the text (ina
single column). Then, choose Data= Text to Columns, and Excel displays the first
of three Text to Columns Wizard dialog boxes. These dialog boxes are identical to
those used for the Text Import Wizard, except that the title bar text is different.

Unfortunately, you can’t use the Data = Text to Columns command on a multiple
selection; this would be quite handy for parsing imported files with several differ-
ent layouts. Even worse, you can't use the Edit = Repeat command to repeat the
Text to Columns command.

Summary

This chapter identifies the various sources for getting data into Excel: entering data
manually, generating data from formulas or macros, using Query or pivot tables,
copying data using the Clipboard, and importing foreign files (including text files)
into Excel) The chapter focuses on Clipboard operations and file importing.

< + @
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Working with
Lists

esearch conducted by Microsoft indicates that Excel is
frequently used to manage lists, or worksheet databases.

This chapter covers list management and demonstrates useful
techniques that involve lists.

What Is a List?

A list i essentially an organized collection of information.
More specifically, a list consists of a row of headers (descrip-
tive text), followed by additional rows of data, which can be
values pr text. You may recognize this as a database table —
which is exactly what it is. Beginning with Excel 5, Microsoft
uses the term list to refer to a database stored in a worksheet
and the term database to refer to a table of information stored

in an external file. To avoid confusion, I adhere to Microsoft’s
terminology.

tover external database files in Chapter 24.

Figure 23-1 shows an example of a list in a worksheet. This
particufar list has its headers in row 1 and has 10 rows of data.
The list occupies four columns. Notice that the data consists
of several different types: text, values, and dates. Column C

contains a formula that calculates the monthly salary from the
value in column B.
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